Chapter 10

Earthwork

10.1 Objectives .................................................................................................................. 10-1
10.2 End-area Volume ....................................................................................................... 10-1
  10.2.1 Preferences ........................................................................................................ 10-1
10.3 End-Area Volume Dialog Options ............................................................................ 10-2
  10.3.1 General (End-Area Volume) .............................................................................. 10-2
  10.3.2 Unsuitable Materials by Station (End-Area Volume) ......................................... 10-4
  10.3.3 Classifications (End-Area Volume) ................................................................ 10-5
  10.3.4 Compaction/Expansion (End-area Volume) ...................................................... 10-6
10.4 Volume Exceptions (End-area Volume) .................................................................... 10-8
  10.4.1 Added Quantities (End-area Volume) ................................................................. 10-9
  10.4.2 Forced Balance (End-area Volume) ................................................................ 10-10
  10.4.3 As Built (End-area Volume) ............................................................................. 10-11
  10.4.4 Annotation (End-area Volume) ........................................................................ 10-12
  10.4.5 End-Area Volume Report Generation ............................................................... 10-13
10.5 Group Exercise: Road 1 Earthwork ......................................................................... 10-17
10.6 Individual Exercise: Route 63 Earthwork ............................................................... 10-20
10.1 Objectives

- Learn the procedures for calculating earthwork quantities with GEOPAK
- Learn how to generate a volumes report

10.2 End-area Volume

The **End-Area Volumes** tool performs the traditional end-area volume calculation to compute cut, fill, and net volumes using a series of cross sections extracted along a previously defined alignment. A complete report listing all computed quantities on a station-by-station basis can also be generated with this command.

10.2.1 Preferences

Preferences are predefined settings stored in the active XIN settings file delivered in the MoDOT workspace. These preferences will be used for creating, annotating and computing end-area volumes on proposed cross sections.

Workflow

Select **Preferences** located at the bottom of the **End-Area Volumes** dialog.

In the **Preferences** dialog, select the preference named **MODOT-Earthwork** and click **Load**.
Before Using This Command

Create cross sections using the **Create Cross Sections** command. Make sure that you have a corridor and a Surface to run volumes against. Display the components in the cross section so that you can determine the subgrade and compute the quantities of component materials, such as asphalt.

Typically, you use this command to calculate excavation and analyze your design after you create a corridor.

Once the Terrain Model is created, you can extract cross sections along the alignment, displaying these surfaces in each cross section. A surface displayed in a cross section is called a cross-section surface.

Because this command calculates volumes between any combinations of Surfaces, you can use it to compute the materials required in your roadway design.

The **End–Area Volumes** application has numerous options available to handle most combinations of calculations required in the typical design process. The user will be given the option to decide which surface(s) to perform calculations along. This is most beneficial for staged construction volume calculations.

Special circumstances such as Unsuitable Materials, Volume Exceptions, Added Quantities, Forced Balance, As-Built, Mass-Haul Diagram, Reporting, etc. are supported in this application.

### 10.3 End-Area Volume Dialog Options

#### 10.3.1 General (End-Area Volume)

**Cross Section Model** lists all the existing cross-section models, which are groups of extracted cross sections that are assigned unique identification numbers. From this list, select a set of cross sections to use as the basis for End-Area volume calculations. When you select a cross section model from this list, the command places a region/fence in the drawing file around the cross sections that compose the model.

**Surface/Type** Under the **General Section** lists surfaces and corridors in the selected cross section model. The default type for a new surface is “Existing”. The default type for surfaces created by Corridor Modeling is “Design”. You may change the types to: Existing, Design, Substratum, None, or Subgrade using the Surface Properties command.
You may have multiple existing, designs, or substrata in a given cross section model. However, you must have only one existing surface for any given cross section at a given station in order to compute volumes. If you have more than one design surface in a section, they should not overlap.

Display the components from the design surface in the cross section so that the subgrade path can be determined. The subgrade is determined starting at the left side of the design surface and following the rightmost path along the surface and its components. This path is then compared against the existing surface and any substrata to compute the areas of volume.

When the Type is set to “subgrade”, end-areas follow the design type until a subgrade type is encountered. End-areas follow the subgrade type until it encounters a design type. If a design type is not connected then end-areas utilizes a vertical drop.

**Method** – Located on the General Selection

- **Standard** employs the average end-area method for computing volumes.
- **Correct for Curvature** compensates for sections in a curve by computing the centroid offset and applying the correction to cut and fill.

**Limits** – Located on the General Selection

- **Station Range** limits the sections for which volumes are calculated by defining start and stop stations.
- **Start** specifies the starting station of the section.
- **Stop** specifies the stopping station of the section.
- **Ignore Areas Smaller Than** specifies an area that you do not want reported.

**Create XML Report** – Located on the General Selection this button indicates whether or not an XML report is created and if it is created, it will open the Bentley Civil Report Browser. The XML file contains cross section information and more detailed volume information.
10.3.2 Unsuitable Materials by Station (End-Area Volume)

Use this dialog as an additional method to calculate unsuitable materials. Unsuitable materials of a specified style can be removed from the existing surface for the entire construction limits over a specified station range. You can specify separate cut and fill depths. Unsuitable Materials defined on this dialog supersedes any defined by the Unsuitable Materials By Feature command.

Unsuitable material located under fill (embankment) is included in the Mass Ordinate calculation. This occurs because materials stripped from under fills automatically increase the amount of material required for a given embankment area. For more details, see the Classifications topic.

Cross Section Model lists all the existing cross-section models, which are models of extracted cross sections that are assigned unique identification numbers. From this list, select a cross section model to use as the basis for end-area volume calculations. When you select a cross section model from this list, the command places a region/fence in the drawing file around the cross sections that compose the model. The command also displays the horizontal alignment and surface(s) used when the cross sections in the model were extracted.

Settings:

Start Station identifies the start station. Select a station from the list or use the locate button to identify the station.

Stop Station identifies the end station. Select a station from the list or use the locate button to identify the station.

Style specifies the style of the unsuitable material.

Cut Depth specifies the cut depth for the material.
Fill Depth specifies the fill depth for the material.

Unsuitable Materials lists all of the specified added unsuitable material sections.

Add adds a single section to the list based on the settings provided.

Change modifies the selected section to the settings provided.

Delete removes the selected section from the list.

10.3.3 Classifications (End-Area Volume)

Use this dialog to control how volumes are calculated and reported for individual materials. Individual materials are those not normally included in the unclassified cut and fill volumes. These include substrata materials, component materials, and materials calculated from the Material Features leaf.

The Cross Section Model lists all the existing cross-section models, which are groups of extracted cross sections that are assigned unique identification numbers. From this list, select a cross section model to use as the basis for End-Area volume calculations, or select the set graphically. When you select a cross section model from this list, the command places a region/fence in the drawing file around the cross sections that compose the model.

(Object)

Object lists all available materials. For components specified as Undercut (for moisture density control), the component is removed from the normal cut totals. You can separately report on this portion of the component.
Source lists all surfaces containing material features. The existing surfaces are displayed first, followed by substrata surfaces, then cross section surfaces.

Parent identifies the corridor containing the component material.

Classification defines to which group the materials are reported: None, Unclassified, Rock, Designed, and Unsuitable. If you set the classification to Ignore, it is not reported.

Mass Ordinate allows you to include the material into the mass ordinate and total volume calculation. Unsuitable material located under fill (embankment) is included in the calculation. This occurs because materials stripped from under fills automatically increase the amount of material required for a given embankment area. In this case, the Include/Exclude toggles are not available.

Cut Factor specifies the cut factor for the surface. Substrata, existing surfaces, and material features use a cut factor. Compaction/Expansion parameters can override this value for existing surfaces.

Fill Factor specifies the fill factor for the surface. Components and existing surface use a fill factor. Compaction/Expansion parameters can override this value for existing surfaces.

10.3.4 Compaction/Expansion (End-area Volume)

Use this dialog to specify aggregate cut and fill factors for given materials over a range of stations. This is necessary since most existing surfaces are topological surveys which do not regard the materials that make up the surface.

Cross Section Model lists all the existing cross-section models, which are groups of extracted cross sections that are assigned unique identification numbers. From this list, select a cross section model to use as the basis for End-Area volume calculations. When you select a cross section model from this list, the command places a region/fence in the drawing file around the cross sections that compose the model. The command also displays the horizontal alignment and surface(s) used when the cross sections in the model were extracted.
Settings

Start Station identifies the start station. Select a station from the list or use the locate button to identify the station.

Stop Station identifies the end station. Select a station from the list or use the locate button to identify the station.

Cut Factor scales computed cut volumes. This parameter defines how much the volume of the cut material will increase after it is removed from the ground. For example, a value of 1.3 means that the cut material will swell 1.3 times its original value. The default value is 1.0.

Fill Factor scales the computed fill volume. This parameter defines how much the volume of the fill material will decrease after it is placed into the site. For example, a value of 0.8 means that the fill material will shrink to 0.8 times its original value. The default value is 1.0.

Description allows you to specify the material description for reporting purposes.

Compaction/Expansion lists all of the specified cut and fill factors.

Add adds a single compaction/expansion factor to the list based on the settings provided.

Change modifies the selected factor values to the settings provided.

Delete removes the selected factor from the list.
10.4 Volume Exceptions (End-area Volume)

Use this dialog to specify sections where you do not wish to compute volumes. For a given volume exception, the volume at the start station is computed. The volume of all stations greater than the start station and less than or equal to the stop station is not computed.

The most common example of a volume exception is a bridge. Because no fill material is required under a bridge, you would not want to compute "fill" volume within these station limits.

**Cross Section Model** lists all the existing cross-section models, which are groups of extracted cross sections that are assigned unique identification numbers. From this list, select a cross section model to use as the basis for End-Area volume calculations. When you select a cross section model from this list, the command places a region/fence in the drawing file around the cross sections that compose the model. The command also displays the horizontal alignment and surface(s) used when the cross sections in the model were extracted.

**Settings**

**Start Station** identifies the start station. Select a station from the list or use the locate button to identify the station.

**Stop Station** identifies the end station. Select a station from the list or use the locate button to identify the station.

**Volume Exceptions** lists all of the specified volume exceptions.
Add adds a single volume exception to the list based on the settings provided.

Change modifies the selected volume exception values to the settings provided.

Delete removes the selected volume exception from the list.

10.4.1 Added Quantities (End-area Volume)

Use this dialog to add additional cut or fill values to the adjusted volumes. Added quantity may be injected at a single station (Start and Stop Station are the same) or distributed linearly over each section in the range that you specify.

**Cross Section Model** lists all the existing cross-section models, which are groups of extracted cross sections that are assigned unique identification numbers. From this list, select a cross section model to use as the basis for End-Area volume calculations. When you select a cross section model from this list, the command places a region/fence in the drawing file around the cross sections that compose the model.

**Settings:**

Start Station identifies the start station. Select a station from the list or use the locate button to identify the station.

Stop Station identifies the end station. Select a station from the list or use the locate button to identify the station.
Type

- **Cut** indicates the addition is a cut value.
- **Fill** indicates the addition is a fill value.
- **Volume** specifies the additional volume.
- **Factor** defines how much the volume of the cut material will increase or decrease after it is removed from the ground. For example, a value of 1.3 means that the cut material will swell 1.3 times its original value. The default value is 1.0.

**Added Quantities** lists all of the specified added quantities.

**Note:** Added Quantities will have to change either the computational output or limit the input of the station range.

- **Add** adds a single additional quantity to the list based on the settings provided.
- **Change** modifies the selected quantity to the settings provided.
- **Delete** removes the selected quantity from the list.

### 10.4.2 Forced Balance (End-area Volume)

Use this dialog to apply forced balance at a given cross section station and apply it to either cut or fill. Forced balance allows you to balance your cut and fill to zero at critical points, such as a bridge, where hauling across may be impractical.

A balance factor is calculated between stations where forced balance is applied. The balance factor is the accumulated fill divided by the accumulated cut up to the given station. If the forced balance is applied to cut, the adjusted cut volumes up to that station are multiplied by the balance factor. If the forced balance is applied to fill, the adjusted fill volumes up to that station are divided by the balance factor. At the forced balance stations, the accumulated cut and fill are reset to zero.

**Cross Section Model** lists all the existing cross-section models, which are groups of extracted cross sections that are assigned unique identification numbers. From this list, select a cross section model to use as the basis for End-Area volume calculations, or select the model graphically. When you select a cross section model from this list, the command places a region/fence in the drawing file around the cross sections that compose the model. The command also displays the horizontal alignment and surface(s) used when the cross sections in the model were extracted.
Settings

Station identifies the cross section station. Select a station from the list or use the locate button to identify the station.

Apply To:

Cut indicates the forced balance is applied to cut.

Fill indicates the forced balance is applied to cut.

Forced Balance lists all of the specified forced balances.

Add adds a single forced balance to the list based on the settings provided.

Change modifies the selected forced balance to the settings provided.

Delete removes the selected forced balance from the list.

10.4.3 As Built (End-area Volume)

Use this dialog to calculate volumes incrementally as the road is being built. Incremental reporting works against cut, fill, and substrata calculations. If you have unsuitable material, it is calculated in full when you specify the first As Built Surface. If you select Include Previous As Built Surface, the unsuitable material is excluded.

If the As Built surface is incomplete, it is assumed to drop vertically. If this is not what you want, edit the cross section surface to reflect the way you want it to behave.

Reporting and Annotation functionality reflect the As Built Volumes.
Cross Section Model lists all the existing cross-section models, which are groups of extracted cross sections that are assigned unique identification numbers. From this list, select a cross section model to use as the basis for End-Area volume calculations. When you select a cross section model from this list, the command places a region/fence in the drawing file around the cross sections that compose the model.

Settings:

- **Compute As Built Volumes** activates Settings and designates to compute As Built Volumes.
- **As Built Surface** allows you to select which cross section surface to use as the current As Built surface. Only cross section surfaces of type None appear in this list. Set the surface type to None before you cut the cross section or update the cross section. None surface type is used to ensure that the As Built surfaces do not interfere with design volume calculations. The final subgrade is included in this list to allow you to make the final incremental calculation.
- **Include Previous As Built Surfaces** when selected compares a previous As Built surface to the current As Built surface. Select this option and select a surface from the dropdown list.

### 10.4.4 Annotation (End-area Volume)

Use this dialog to annotate existing cross sections with area and volume information.

Cross Section Model lists all the existing cross-section models, which are groups of extracted cross sections that are assigned unique identification numbers. From this list, select a cross section model to use as the basis for End-Area volume calculations. When you select a cross section model from this list, the command places a region/fence in the drawing file around the cross sections that compose the model. The command also displays the horizontal alignment and surface(s) used when the cross sections in the model were extracted.

**Note:** All entities for display under **End-Area Volumes >Annotation** are annotated except **Cut Volume**, **Fill Volume**, **Mass Ordinate** and **Tabulated Volume** when a skewed section is encountered. Everything else on the **End-Area Volume** command is ignored.
(List) lists all of the entities available for display.

Object lists available entities. For unsuitable materials shapes, cut and fill parts are displayed separately.

Prefix specifies the alphanumeric text to include at the beginning of the annotation.

Suffix specifies the alphanumeric text to include at the end of the annotation.

Precision defines how many decimal places are expressed with the annotation.

Location specifies where the annotation is placed relative to the cross section.

Name/Color (Symbology) allows you to select a named symbology. Click on a color to open the Text Symbology or Line Symbology dialog. Set the horizontal and vertical offsets and justification values of the text symbology to control the exact placement of the annotation.

You can annotate the total quantities of the substrata, component materials and material features by selecting the Tabulated Areas and Volumes. See Create Corridor for more information on creating component shapes, and Create Cross Section for their display.

The display symbology for the component shape annotation and material feature shapes are defined by their respective surface feature styles. The display symbology for substrata shapes is defined by the cross section named symbology of the surface.

10.4.5 End-Area Volume Report Generation

Under the General tab there is the option to include the creation of XML output when the end-area volumes are run. Upon completion the Bentley Civil Report Browser will automatically open. The XML file contains cross section information and more detailed volume information.
Chapter 10 – Earthwork

The XML files are temporary files that contain data that is formatted into reports by the View XML Reports command. The XML files are temporary unless you use the File > Save As on the Bentley Civil Report Browser to save them as HTML or text files.

A report is the output generated when you display data from an XML file using the View XML Reports command. The View XML Reports command allows you to choose an XSL style sheet, which specifies exactly what information to pull from the XML file and how to format it. The XML file contains raw or computed data; the XSL file specifies how to format the data into a report.

**Dialog Box Options**

![Bentley Civil Report Browser](image)

**File (menu)**

Open activates the Open dialog, opens an XML data file. After you open an XML file, the name of the file is reported in the title bar at the top of the dialog.

Save As displays the Save As dialog, which saves the report output into an HTML file, an XML file, a DOC file, XLS file or a text file.

Many of the reports are formatted HTML content. Those reports can be saved as HTML files. However, some of the reports are composed of simple text. Those reports are saved as text files (*.txt).

Note: If the style sheet used for the report contains embedded cascading style sheet references, you need to locate the CSS where it can be found by whoever opens the DOC file or you will get a warning that indicates the reference cannot be found.

Append displays the Append dialog, which appends the contents of the right pane to an existing .txt file.

Page Setup displays the Page Setup dialog, which allows you to select paper size, orientation, margins, and headers and footers for printing.
**Print** displays the print dialog, which allows you to print the report.

**Print Preview** provides a preview of the printed report. The print preview reflects the current settings from the Page Setup dialog.

**Exit** exits the Bentley Civil Report Browser program.

### Tools (menu)

- **Style Sheet Root** specifies a directory for locating XSL files. Bentley Civil Report Browser will find the XSL files in the specified directory and in any of its subdirectories.

When you change the Style Sheet Root, the new root directory must contain copies of the following from the delivered directory structure:

- _Themes directory.
- format.xsl contains the scripting that allows you to dynamically set the precision and formatting of the output.
- raw-xml.xsl outputs file

The browser will not operate correctly without them. The only exception is if all style sheets contained in the new root have been modified to remove the links to the cascading style sheets. In that case, the _Themes directory is no longer needed. Once the files are copied, you can modify them.

**Format Options** activates the Format Options dialog, which lets you set the precision and format for displaying a variety of types of data in the report and utilizes the format.xsl.
10.5 Group Exercise: Road 1 Earthwork

1. Within the data_10 folder, open the design file Corridors_J2P0200.dgn.

2. Highlight the Road1 Corridor and in the Preferences and change the Design Stage from Preliminary design to Final design.

   *This will drop the templates closer to each other and make interpolation much more accurate.*

3. Within the data_10 folder, open the design file XS_J2P0200_Road1.dgn.

4. Open the road1 model. This model should contain the Road1 cross sections that we will use to run the End Area Volumes tool on.

5. Select the End Area Volume tool from the Corridor Modeling task group.

6. Select Preferences located at the bottom of the End-Area Volumes dialog.

7. In the Preferences dialog, select the preference named MODOT-Earthwork and click Load

   ![Preferences](image)

Preferences are predefined settings stored in the active XIN settings file delivered in the MoDOT workspace. These preferences will be used for creating, annotating and computing end-area volumes on proposed cross sections.

8. Close the Preferences selection dialog.
9. In the *End-Area Volumes* dialog, complete the *General* settings as shown below. Make sure you toggle on the *Create XML Report*, and select the volume units of choice.

10. Complete the *Classifications* settings as shown below.
11. Click **Apply**. This will complete the following five tasks when processing.

- Compute end-areas.
- Compute volumes between sections.
- Label cross sections with computed values.
- When the volumes computations are complete, the *Bentley Civil Report Browser* will open when the toggle is activated. The report browser allows the designer to review the end-areas as well as computed volumes for all surfaces.

12. Look at multiple reports available in the **Evaluation** folder.

13. In the *Bentley Civil Report Browser*, select **Tools > Format Options** and adjust values to your preferences. Notice how the report updates when changes are applied. Click **Close** when adjustments are complete.

14. In the report browser, toggle through the different earthwork reports available on the left to comprehend the many options available from these calculations.

15. **Close** the *Bentley Civil Report Browser*.

16. **Close** the *End-Area Volumes* dialog.
10.6 Individual Exercise: Route 63 Earthwork

1. Within the data_10 folder, open the design file Corridors_J2P0200.dgn.

2. Highlight the Route63 Corridor and in the Preferences and change the Design Stage from Preliminary design to Final design.

3. Within the data_10 folder, open the design file XS_J2P0200_Route63.dgn.

4. Open the Route63 model. This model should contain the Route63 cross sections that we will use to run the End Area Volumes on.

5. Select the End Area Volume tool from the Corridor Modeling task group.

6. Select Preferences located at the bottom of the End-Area Volumes dialog.

7. In the Preferences dialog, select the preference named MODOT-Earthwork and click Load.

Preferences are predefined settings stored in the active XIN settings file delivered in the MoDOT workspace. These preferences will be used for creating, annotating and computing end-area volumes on proposed cross sections.

8. Close the Preferences selection dialog.

9. In the End-Area Volumes dialog, complete the General settings as shown below. Make sure you toggle on the Create XML Report, and select the volume units of choice.
10. Complete the *Classifications* settings as shown below.

11. Click **Apply**. This will complete the following five tasks when processing:
   - Compute end-areas.
   - Compute volumes between sections.
   - Label cross sections with computed values.
   - When the volumes computations are complete, the *Bentley Civil Report Browser* will open when the toggle is activated. The report browser allows the designer to review the end-areas as well as computed volumes for all surfaces.

12. Look at multiple reports available in the **Evaluation** folder

13. In the *Bentley Civil Report Browser*, select **Tools > Format Options** and adjust values to your preferences. Notice how the report updates when changes are applied. Click **Close** when adjustments are complete.

14. In the report browser, toggle through the different earthwork reports available on the left to comprehend the many options available from these calculations.

15. **Close** the *Bentley Civil Report Browser*.

16. **Close** the *End-Area Volumes* dialog.